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1. Introduction to Kernel Recovery for iPod 

1.1 Using this Manual 

Welcome to the User Guide of Kernel Recovery for iPod Software- an eminent and flawlessly 
designed iPod recovery software. This User Guide is intended to offer you a step-by-step guidance for 
performing iPod data recovery with the use of Kernel Recovery for iPod. Therefore, we suggest you to 
go through the user guide carefully before recovery vital iPod data with the use of Kernel Recovery for 
iPod. You can use Table of Contents for navigating through different segments of the User Guide for 
Kernel Recovery for iPod, as it contains all the topics present in the guide in a chronological order. 
Mentioned below are the topics discussed in the varied segments of this user guide: 

 Introduction to Kernel Recovery for iPod- Provides overview of Kernel Recovery for iPod 
software and key features. Also, mentioned here are the system requirements for installation 
of the software.   

 Getting Started- Offers details of installation and un-installation procedure of software  

 Understanding the User Interface- Explore user interface of Kernel Recovery for iPod 
Software. This section also lets you know about the menus and sub-menus for performing 
iPod music files recovery.  

 Perform iPod Recovery- Describes the process by which you can recover all the lost, deleted 
or inaccessible music files from your iPod using the software. 

 Purchase and Support- Provides information on free download, purchase and register issues. 
Offers solution to varied frequently asked questions during recovering data with the help of 
software.  

 Legal Notices- Provides information about copyright notices, trademarks, disclaimer, and 
license agreement related to Kernel Recovery for iPod software.  

We suggest experienced users to use table of contents to fetch information related to task they need 
to perform using the software.  

1.2 About Kernel Recovery for iPod 

Kernel Recovery for iPod software helps you to recover crucial music files, graphics, videos, 
documents and other contents of your iPod that have become corrupt, damaged or have been 
deleted from your iPod. Usually, crashes and corruption result in occurrence of error message on the 
screen of your iPod. You might have some problem in opening an image file, playing music files in 
iTunes or access you iPod. This software recovers damaged, deleted or lost data from your corrupt or 
crashed iPod in all cases of corruption. Some of the errors resolved by Kernel for iPod are: 

 "There was an error in the iTunes Store. Please try again later." 
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 "Firmware update failure" 

 "the iPod ** cannot be updated, the required folder cannot be found" 

 "Can't lock iPod. Please check if any other applications are using iPod and try again" 

 "iTunes folder cannot be found" 

 "Disk is locked" 

 "Unable to Check for Purchased Music because an error occurred (-5000 error)." 

Don‟t get bothered with this situation that might seem to be hopeless to you, as a recovery solution 
will resolve all your worries away. Kernel Recovery for iPod is compatible for recovering data from all 
models of Apple iPod such as iPod Shuffle, iPod Nano, iPod Mini, iPod Touch, iPod Mini, Hard drive 
based, touch screen and video capable iPods etc. Being a user-friendly and efficient iPod data 
recovery tool, Kernel Recovery for iPod supports retrieving data lost due to virus attack, inappropriate 
handling of device, formatting and crashed iPod media, frozen iPod, sad face icon error, exclamation 
mark icon error or any other hardware malfunction. You can recover music files in any format 
including in MIDI, AIFF, M4A, OGG, RPS, M4P, AU, AVI, MOV, ASF, WMV, MP4, WMA, MP3, MPG, 
MPEG, GIF, WAV etc.  

1.3 Key Features 

Being comprehensive iPod recovery software, Kernel Recovery for iPod software is known for its 
accurate and assured results and excellent performance. Mentioned below are the key features of this 
software: 

Fast and accurate iPod data recovery- Recovers all files from your iPod which were either corrupt, 
lost, damaged or become inaccessible accurately and efficiently  

Comprehensive recovery- Performs comprehensive recovery and retrieves audio, video, sound 
files, image files, documents, folders and documents 

Recover all file formats- Recovery of a variety of file formats is possible including MIDI, AIFF, M4A, 
OGG, RPS, M4P, AU, AVI, MOV, ASF, WMV, MP4, WMA, MP3, MPG, MPEG, GIF, WAV etc 

Preserves data integrity- Ensures preservation of properties of data recovered from the iPod 
memory so that file becomes easily accessible.  

Powerful Recovery modes- Provides user with three robust recovery modes i.e. Standard, 
Advanced and Raw Scan to  

Resolves error messages- Resolves occurrence of error messages such as “Disk is locked”, “iTunes 
folder cannot be found” and “Firmware update failure, Disk write error” etc which often hamper 
smooth functioning of iPods 

Recovery in varied conditions- Typical iPod crash conditions such as virus invasion, improper 
device handling, hardware malfunctions, iPod update and iPod Reset (with iTunes software), 
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formatted and crashed iPod media, frozen iPod, Sad face icon error, Exclamation Mark icon error etc 
are easily dealt with this software.  

Supports all Apple iPod models- Software supports recovery from Apple iPod models such as iPod 
Shuffle, iPod Nano, iPod Mini, iPod Touch, iPod Mini, Hard drive based, touch screen and video 
capable iPods.  

Intuitive Graphical User Interface- Designed with interactive graphical user interface, user doesn‟t 
need to have in-depth technical know-how to perform iPod data recovery 

Available as Free Evaluation Version- Available as free to evaluate version, you can experience the 
working, features and functioning of software without spending anything.  

1.4 System Requirements 

The various pre-requisites for installing and running Kernel Recovery for iPod can be broadly 
classified into two major categories – Hardware requirements and Software requirements. 

1.4.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

 You should have at-least 10 MB of free disk space if you want to repair and 
save a 10 MB.doc file. 

1.4.2 Software Requirements: 

The requirements are as follows: 

1.4.2.1 Operating System Requirements 

Supported operating systems: 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 
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 Windows NT 

 Windows 98 

 Windows 95 

Supported iPods for Data Recovery: 

All Apple iPod models;  

 iPod Shuffle 

 iPod Nano 

 iPod Mini 

 iPod Touch 

 iPod Mini 

 Hard drive based, touch screen and video capable iPods
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2. Getting Started 

Now that you have understood the features and potential of Kernel Recovery for iPod, you are ready 
to get hands on experience of the software. To start repairing corrupt, damaged or lost iPod files, you 
will first need to download and install this software. 

It is strongly recommended that before installing Kernel Recovery for iPod, you should go through the 
installation pre-requisites for the software so that it can be assured that your computer is appropriately 
configured to run the software. 

2.1 Downloading Kernel Recovery for iPod for the First Time 

After checking your computer with the prescribed system requirements for Kernel Recovery for iPod, 
you can download and install the software on your computer. You can purchase the full version of the 
software from any one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel Recovery for iPod before buying it, you can download the evaluation 
version from the following link: 

http://www.nucleustechnologies.com/ipod-data-recovery.html  

 You can repair files saved on your iPod by using the evaluation version of 
Kernel Recovery for iPod; however, the repaired file will not be saved. To save 
the repaired music files you need to purchase the Full version of the software. 

2.2 Installing the Software 

After downloading the executable file for Kernel Recovery for iPod, you can install the software by 
running the file. To install Kernel Recovery for iPod: 

1. Double-click the setup exe file to open the Kernel Recovery for iPod Setup Wizard. Click the 
Next button 

2. On the Setup- Kernel Recovery for iPod screen, click the Next button  

3. Select the I accept the agreement option and click the Next button to continue  

4. Follow the on-screen instructions and select the location for installing the software etc. The 
setup install completion screen will be displayed. 

5.  Click the Finish button to exit setup. Main window of Kernel Recovery for iPod software will be 
launched. 

 

 

http://www.nucleustechnologies.com/ipod-data-recovery.html
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2.3 Uninstalling the Software 

You may need to uninstall and re-install Kernel Recovery for iPod. To uninstall Kernel Recovery for 
iPod: 

1. Click the Start  All Programs Kernel Recovery for iPod  Uninstall Kernel Recovery for 
iPod.  A warning message will be displayed. 

2. Click ‘Yes’ to uninstall Kernel Recovery for iPod. 

 Before proceeding to uninstall Kernel Recovery for iPod, you must ensure that 
the software is not running. 

You can alternatively uninstall Kernel Recovery for iPod from the Control Panel by performing the 
following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel Recovery for iPod and click Remove. A warning message will be displayed. 

3. Click ‘Yes’ to uninstall Kernel Recovery for iPod 
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3. Understanding the User Interface 

Now that Kernel Recovery for iPod has been installed on your computer, you can start using the 
software after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel Recovery for iPod comprises four main menus – Recovery, View, Tools, and 
Help. 

3.1.1 Recovery Menu 

The Recovery menu comprises four menu items. 

 

Figure 3.1: Recovery Menu 

Menu items in the Recovery menu: 

Field Name Field Description 

Recover Selected Select to recover and save the selected items 

Save Recovery Snapshot Select to save .KER file for the scanning process. 
iPod drive can be scanned and its snapshot can 
be saved with this option. Reload the saved .KER 
snapshot another time and save the re-scanning 
time of the drive.  

Load Recovery Snapshot Select to load the saved snapshot file (.KER) to 
Kernel Recovery for iPod. 

Exit Select to close the software 
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3.1.2 View Menu 

The View menu comprises three menu items. 

 

Figure 3.2: View Menu 

Menu Items in the View menu: 

Field Name Field Description 

Icons Select to view listed recovered files in Icons 
like view 

List Select to view listed recovered files in List like 
view  

Details Select to view listed recovered files in 
detailed view with complete information 

3.1.3 Tools Menu 

The Tools menu comprises five menu items. 

 

Figure 3.3: Tools Menu 

 Menu items in Tools menu: 

Field Name Field Description 
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Find Files Select to find specific file(s) from the 
recovered file(s) such as type *.gif and all gif 
files will get listed 

File Filters Select to filter the search process of file(s) 
amongst the recovered file (s) such as .mp3 
music files from hundreds of recovered files 

Settings Select to define settings for searching data, 
recovery and saving process  

Drive Information Select  to know information about the 
selected drive 

Live Update Select this option to update Kernel Recovery 
for iPod with the latest updated version if 
available online. 

 

3.1.4 Help Menu 

The Help menu comprises three menu items. 

 

Figure 3.4: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Select this option to view User‟s Help Manual of 
Kernel Recovery for iPod  

Buy Online Select this option to purchase Kernel Recovery 
for iPod online  
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About Kernel Recovery for iPod Select this option to view support and version 
related information about Kernel Recovery for 
iPod 

3.2 Tool-bar 

The tool-bar in Kernel Recovery for iPod is displayed below the menu-bar. The tool-bar provides a 
convenient and user-friendly method to perform certain actions that can also be performed by using 
the menu-bar. Read the information in the table below to find out more details about the tool-bar 
buttons: 

Button Button Description 

 

Select to recover and save the selected files and folders 
listed by the software. 

 

Select to save snapshot of the scanned drive. The 
scanned process will be saved in .KER file  

 

Select to load the saved snapshot file (.KER) to Kernel 
Recovery for iPod  

 

Select to enter and search specific file types amongst 
thousands of file(s) thus recovered  

 

Select to define settings for Kernel Recovery for iPod 

 

Select to update Kernel Recovery for iPod with current 
version of the software available on Nucleus Data 
Recovery server 

 

Select to purchase Kernel Recovery for iPod online 
through Nucleus Data Recovery website 

 

Select to view the User's Help Manual of Kernel Recovery 
for iPod 
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4. Performing iPod Recovery 

Now that you have complete familiarity of the user interface of Kernel Recovery for iPod, you are 
ready to repair music files. Using Kernel Recovery for iPod, you can recover data from Logical device 
as well as Physical device: 

4.1 Logical Device Recovery 

Logical Device Recovery is performed on the partitions that are found by Kernel Recovery for iPod. All 
the Logical Devices found by the software are listed from where you can select the drive and perform 
the recovery process. Kernel Recovery for iPod offers three robust recovery modes for scanning the 
iPod and performing effective data recovery. You can select the mode according to the iPod 
corruption or condition that made the data in iPod inaccessible. All three recovery modes are 
described below:  

4.1.1 Standard Scan 

Standard Scan is a quick recovery mode that efficiently scans the selected iPod drive and retrieves 
recently deleted or lost files. Mentioned below is the step-by-step process for performing recovering 
data from iPod through Standard Scan: 

1. Select the Standard Scan option from the main window, following screen gets displayed: 
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Figure 4.1: Selected Drive Information for Standard Scan 

Select the drive that contains inaccessible data from the Logical Devices section in the left panel. 
The iPod recovery tool displays the drive information in the right panel; now click the Next button to 
continue the recovery operation 

2. Software will display information related to the selected iPod drive. Click the Next button to 
continue 

3. Kernel Recovery for iPod initiates the scanning process for the selected iPod drive, as shown 
below: 
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Figure 4.2: Scanning drive for Standard Scan 

 Note: Click the Hide Progress button to hide or display the scanning process 

depicted at bottom of the window. 

After the software completes scanning, it displays the following message: 

 

Figure 4.3: Message for selecting Advance Scan 

Click OK to continue. 
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4. Software displays all the recovered files and folders in a tree-like structure. Select the file to check 
its preview before saving it: 

 

Figure 4.4: Display of recovered files 

The files which were deleted from the iPod and are now recovered with the software are displayed in 
Red color. Select the required folders and files that you want to save and click the Next button or 
Recover Selected button from the toolbar.  

5. Define a safe location for saving the recovered files. Software will start saving after you define the 
saving location: 
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Figure 4.5: Saving Process 

4.1.2 Advance Scan 

Advance Scan is more powerful but slow recovery mode from iPod drives. This scan mode enables 
successful data recovery from situations of frozen iPod, iPod displaying sad face or exclamation 
mark. This mode is slow in operation as compared to Standard Scan mode and scans the drive 
recursively to search for lost data. Mentioned below is the step-by-step process to perform iPod data 
recovery with the Advance Scan option: 

1. Select the Advance Scan option from the main window, following screen gets displayed: 
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Figure 4.6: Selected Drive information for Advance Scan  

Select the drive from the left panel for scanning and click the Next button to continue. 

2. Kernel Recovery for iPod displays comprehensive information about the selected drive. Click the 
Next button to continue the scanning process for the drive to locate file systems on drive.  
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Figure 4.7: Scanning drive for Advance Scan 

 Note: Click the Hide Progress button to hide or display the scanning process 
depicted at the bottom of the window 

 

3. Software displays the file system found in the drive. Select the appropriate file system and click the 
Next button to continue. 
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Figure 4.8: File system found in the drive 

Software will start recovering data and after the process completes, the recovered files and folders 
are enlisted in a tree-like structure in the software.  

4. Select the files and folders to check the preview before saving them.  

5. To save the recovered items, click the Next button or the Recover Selected button from the 
toolbar. Software displays a successful saving message.  

 Note: File(s) and Folder(s) that were permanently deleted and are now 
recovered with Kernel Recovery for iPod are displayed in Red color. 

4.1.3 Raw Scan 

Raw Scan mode scans every sector of the drive and then recovers every found file and folder. This 
scan is comparatively slower than the Standard and Advance Scan. Select this mode when you 
cannot find the required files with the other two modes. Mentioned below is the step-by-step process 
to perform data recovery through Raw Scan: 
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1. Select the Raw Scan option from the main window, following screen will get displayed: 

 

Figure 4.9: Selected Drive information for Raw Scan 

Select the drive that you want to scan and click the Next button. 

2. Software will display comprehensive information about the selected drive: 
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Figure 4.10: Comprehensive Drive information of selected drive 

3. Click the Next button, software will display the File Types window. From here you can select the 
file types to be recovered through the Raw Scan mode.  
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Figure 4.11: File Types Window for Raw Scan 

With Raw Scan mode, you can recover selected file types. So, select the file types and click OK to 
continue with the recovery. 

Since the mode is slow in performing data recovery operations, it might take more time to scan and 
recover the files.  

4. Recovered items are enlisted in a tree-like structure in the left panel of the software. Select the 
check the preview of recovered files before saving them:  
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Figure 4.12: Preview of recovered files 

5. Select files and folders that you want to save and click the Next button or the Recover Selected 
button from the toolbar.  

Note: File(s) and Folder(s) that were permanently deleted and are now recovered with 
Kernel Recovery for iPod are displayed in Red color. 

 

4.2 Physical Device Recovery 

Physical Device Recovery is performed on hard drive of iPod where Kernel Recovery for iPod 
searches for lost or missing partitions from the drive. Using this recovery mode, you have two options 
for performing recovery option-  

a) Use Existing Partition Info  

b) Search Partition 
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iPod Data Recovery with 3 modes for Physical Devices  

Kernel Recovery for iPod offers three robust recovery modes for scanning the iPod and performing 
effective data recovery. You can select the mode according to the iPod corruption or condition that 
made the data in iPod inaccessible. All three recovery modes are described below: 

4.2.1 Standard Scan 

Standard Scan performs scan quickly and supports recovery of recently deleted files and folders from 
iPods. Mentioned below is the step-by-step process of recovering iPod data from Physical device: 

1. Select the Standard Scan option from the main window, following screen gets displayed: 

 

Figure 4.13: Selected Drive information for Physical Device Standard Scan 

Select the drive from Physical Devices section. Kernel Recovery for iPod displays the drive 
information in the right panel. Click the Next button to view the recovery options: 
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Figure 4.14: Select Option Window 

2. Select the appropriate option and click OK to continue. Software displays the comprehensive 
information of the drive.  

3. Click the Next button to continue. Software initiates the scanning operation for the selected drive 
and searches for the lost or inaccessible data.  
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Figure 4.15: Scanning drive for lost data with Standard Scan 

 

 

 Note: Click the Hide Progress button to hide or display the scanning process 
depicted at bottom of the window.  

After complete scanning, software displays following message: 

 

Figure 4.16: Message to select Advance Scan 

Click OK to continue. 

4. Software enlists al the recovered files and folders in tree-like structure. Select the file and folder to 
check preview of the recovered file before saving them.  

The files which were deleted from the iPod and are now recovered with the software are displayed 
in Red color. Select the required folders and files that you want to save and click the Next button 
or Recover Selected button from the toolbar.   

5. Define a safe location for saving the recovered files. Software will start saving after you define the 
saving location: 
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Figure 4.16: Saving Process 

 

4.2.2 Advance Scan 

Advance Scan is more effective than the Standard Scan and performs deep scanning of the drive for 
iPod data recovery.  

1. Select the Advance Scan option from the main window and Select the drive for scanning. Then 
click the Next button to view the recovery options.  

2. Select any of the option from Use existing partition or Search Partition options. Click OK to 
continue. Software will display the comprehensive information of the selected partition.  

3. Software will search the partition for lost data. As the scanning process is slow so it might take 
more time as the software searches for data in every sector of the drive.  

Note: Click the Hide Progress button to hide or display the scanning process depicted at 
bottom of the window.  

After complete scanning, software displays the existing file systems of the partition. Select the 
appropriate file system and click the Next button to continue. 
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Figure 4.17: File System Information for Advance Scan 

Software will start searching for lost fragments, data etc from the selected file system.  

4. Recovered files and folders get displayed in a tree-like structure by the software.  

Note: File(s) and Folder(s) that were permanently deleted and are now recovered with 
Kernel Recovery for iPod are displayed in Red color. 

Select and check the preview of the recovered items before saving them.  

5. Select the files and folders to save the files by clicking the Next or the Recover Selected button 
from the toolbar. Software will save the selected items at defined disk location.  

 

4.2.3 Raw Scan 

Slow in operation as compared to the other two recovery modes, Raw Scan is more result-oriented 
and performs a recursive scan of every sector of the drive to ensure maximum and accurate data 
recovery. Steps to perform data recovery with Raw Scan are similar to the Logical Device Recovery 
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(Raw Scan). Similar to the other scan modes of Physical Device Recovery, Raw scan provides two 
options: 

 Use existing partition info: performs recovery from the existing partitions information on the 
drive  

 Search partition: searches for data to locate missing and deleted partitions from the drive and 
then performs iPod data recovery  

The best feature of this scan mode is that it offers filter options to narrow the search as per your 
requirement. You can easily define your requirement by adding the file extensions and the mode will 
recover only the files with the extension provided by you.  
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5. Purchase and Support 

Although you can use Kernel Recovery for iPod evaluation version for free and experience the 
capabilities of the software but there are certain features that are not available in the evaluation 
version. 

5.1 Purchase 

By using the evaluation version of Kernel Recovery for iPod, you can repair corrupt, damaged or 
inaccessible music files; however, you cannot save the repaired files. 

You will need to purchase the full version of the software to proceed with the saving process.  

You can buy the full version of Kernel Recovery for iPod from any one of our authorized resellers – 
Element5, Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an 
email comprising the URL to download the full version of Kernel Recovery for iPod and activation 
details of the software. 

 

5.2 Support 

We have an extensive and efficient support system in place to assist our customers with all issues 
related to using Kernel Recovery for iPod. The software comes with an embedded help manual that 
can be accessed by clicking HelpSoftware Help in the menu-bar. You can also press the F1 key on 
the keyboard of your computer to access the embedded help of Kernel Recovery for iPod. 

You can access the online help for Kernel Recovery for iPod at 

http://www.nucleustechnologies.com/Online-Helps.html 

View Animated Working demo of the software at  

http://www.nucleustechnologies.com/ipod-recovery-animated.html  

We also have live support wherein you can chat with our software experts at 

http://www.nucleustechnologies.com/Support.html . 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for US/CANADA) 

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/ipod-recovery-animated.html
http://www.nucleustechnologies.com/Support.html
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You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

5.3 Troubleshooting 

How should I start working with Kernel Recovery for iPod? 

In order to conduct iPod recovery with Kernel Recovery for iPod, perform the following steps: 

1. Install the software on a healthy drive. Do not install the software on the corrupt drive 

2. Connect iPod through USB port 

3. Launch Kernel Recovery for iPod 

4. Select the Recovery Mode: Standard Scan, Advance Scan and Raw Scan 

5. Software will display the iPod drive in Logical and Physical Devices section in the left panel 

6. Select the drive and start scanning the drive to retrieve files 

7. Save the recovered items to a safe and healthy drive location 

 

My iPod doesn’t get detected in Kernel Recovery for iPod. What to do? 

Kernel Recovery for iPod will not function beyond the main screen until it detects an iPod. Software 
displays the following message as it launches and iPod is not detected: 

mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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Figure 5.1: Device Not Found window 

You can perform the following steps to check if your iPod is not detected by the software: 

1. iPod is connected to your system 

2. iTunes Preferences Configuration is allowing direct access to your iPod 

3. Uninstall iTunes from your computer and then reconnect iPod to computer 

4. Install Kernel Recovery for iPod on the system where iTunes Recovery is not installed 

5. If you are working with Windows Vista, then ensure that the User Account Control (UAC) is 
disabled. To disable UAC, go to Control Panel > User Account On or Off > Uncheck UAC and 
then restart your computer 

5.4 Frequently Asked Questions (FAQ) 

My iPod is Frozen, What should I do?  

Don‟t worry if your iPod is frozen, it‟s similar to the situation when your computer crashes. To recover 
from frozen iPod situations, you need to restart the iPod. Since, iPods do not have On/OFF buttons, 
you need to reset them and to do so, follow the steps given below: 

 Check if the hold button of your iPod is On, if it is On then this will engage your iPod and will 
not allow you to perform any function. Turning the iPod off might make it work for you and 
make you iPod work again.  
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 Reset the iPod, it is similar to rebooting the computer, reset/reboot you iPod. To reset your 
iPod follow the steps given below: 

1. Press the Menu button and at the same time select the center button, hold for 5-10 
seconds. This will restart the iPod 

2. Repeat the steps if this doesn‟t works for the first time 

3. If the problem persists, then charge your iPod and restart again 

4. If you still face the same situation, then you need to perform iPod data recovery 

 

iPod Restore - What to Do?  

At times, you might come across the following error message: 

"iTunes has detected an iPod in recovery mode - Use iTunes to restore" 

During these situations, you are left with no option but to format your hard drive. iPod will erase entire 
iPod drive structure and user is left with empty iPod. You go through the following two situations: 

1. Cleaned iPod but files still exists in iTunes music library 

In this case, you need to connect your iPod to your computer and re-sync with iTunes 

2. Cleaned iPod but there are no music or video files left 

In this situation, you need to perform iPod data recovery as the restore function has deleted the files 
but they are still there in your drive. Every item in the iPod is recovered easily with Kernel Recovery 
for iPod. 

 

My iPod displays Sad Face Icon. Is the data recoverable? 

Display of Sad Face Icon means broken hard drive that is iPod is down with some hardware issue 
and is not easily repairable. On the worst, if the user has not backed up the iPod data, then possibility 
is that your favorite music, audio and videos are gone. However, you can still try the following steps to 
refrain this situation: 

Test the iPod and place it in „Disk Mode‟- Manually  

1. Toggle the Hold switch ON and OFF 

2. Press and hold Menu and Select buttons simultaneously for 5-10 seconds until Apple logo appears 

3. Now hold the Select button with Play/Pause button till the Disk Mode screen appears 

4. In Disk Mode, iPod will display a large tick sign at the top of LCD with „Disk Mode‟ written at the top 
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If there are no critical hardware issues with your iPod, it will start working again and you can access 
all your favorites once again.  

Manual Disk Mode Testing Do Not Works 

If the manual Disk Mode doesn‟t works then it is quite sure that your iPod has some serious hardware 
issues and so try to recover your data back with Kernel Recovery for iPod 

 

My iPod displays Exclamation Mark Icon. What does this mean? 

Occurrence of Exclamation mark shows that the iPod hard drive has lost its configuration settings or 
there is some communication error inside iPod and the data must be recovered back as soon as 
possible. Use Kernel Recovery for iPod to retrieve vital data.  

 

How to Perform Recovery for bad iTunes Auto-Sync 

Auto-sync option of the iTunes software automatically updates the files of iPod with the files existing 
in the iTunes Library of the computer which is connected. Usually, users feel that this option is meant 
to update iPod and iPod will get copied to the connected computers but it is not so. iPod is a read 
only device which can only receive files from iTunes.  

The situations that occur due to mis-belief of iTunes Auto-Sync option are: 

 I connected my iPod to a computer, iTunes started and I watched all the music and files on my 
iPod suddenly disappear?   

 I reinstalled Windows, connected my iPod to a computer, iTunes started and now my songs 
are all missing?   

 I connected my iPod to a friend‟s computer, lost my music and now have my friends music on 
my iPod.  

During the bad Auto-Sync situations, it becomes important to retrieve the files from iPod. You can 
come across the following two cases: 

When songs are there on iTunes but are missing from iPod 

You don‟t need to worry, as nothing has been lost. You just need to connect your iPod to the 
computer and iTunes will automatically synchronize with iPod and copy the songs from computer to 
the iPod 

When songs are lost from iPod and iTunes 

In this situation you need to perform iPod data recovery from the iPod drive to recover the lost items. 
Kernel Recovery for iPod performs this function efficiently 
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6. Legal Notices 

This section comprises the legal specification about Kernel Recovery for iPod and the company 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

6.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual 
and documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all 
rights reserved. Under the copyright laws, this user manual cannot be reproduced in any form without 
the prior written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent 
Liability is assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

6.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 
2000 Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, and MS-DOS are 
registered trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective 
companies. 

6.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is 
subject to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides 
no warranty with regard to this manual or any other information contained herein and here by 
expressly disclaims any implied warranties of merchantability or fitness for any particular purpose with 
regard to any of the foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no 
liability for any damages incurred directly or indirectly from any technical or typographical errors or 
omissions contained herein or for discrepancies between the product and the manual. In no event 
shall NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, 
consequential special, or exemplary damages, whether based on tort, contract or otherwise, arising 
out of or in connection with this manual or any other information contained herein or the use there of. 

6.4 License Agreement 

Kernel Recovery for iPod Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED. The terms and conditions of this License describe the 
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permitted use and users of each Licensed Copy of Kernel Recovery for iPod. For purposes of this 
License, if you have a valid license, you have the right to use a single Licensed Copy of Nucleus 
Kernel. 

Scope of License 

Each Licensed Copy of Kernel Recovery for iPod may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. 
All rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely 
and exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You 
may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative 
works based on, Nucleus Kernel, nor permit anyone else to do so. You may not make access to 
Nucleus Kernel available to others in connection with a service bureau, application service provider, 
or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel Recovery for iPod, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested 
with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all 
use of the copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes 
an essential part of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED authorize you or anyone else to use Kernel Recovery for iPod in applications or 
systems where Kernel Recovery for iPod failure to perform can reasonably be expected to result in a 
significant physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to 
hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all claims or 
losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction 
and venue for all matters relating to this License shall be in courts and for a located in the State of 
Delhi, and you consent to such jurisdiction and venue. There are no third party beneficiaries of any 
promises, obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED herein. 

 Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this 
License by you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED of any other or future violation of the same provision, or any 
other provision, of this License. 


